A I:l 1 D A Altera Monitor Program
—u b ® Tutorial

For Quartus Il 10.1

1 Introduction

This tutorial presents an introduction to the Altera Monitor Program, which can be used to compile, assemble, down-
load and debug programs for Altera’s Nios II processor. The tutorial gives step-by-step instructions that illustrate
the features of the Monitor Program.

The Monitor Program is a software application which runs on a host PC, and communicates with a Nios II hardware
system on an FPGA board. The Monitor Program is compatible with Microsoft Windows operating systems, includ-
ing XP, Vista, and Windows 7. It allows the user to assemble/compile a Nios II software application, download the
application to a Nios II hardware system, and then debug the running application. The Monitor Program provides
features that allow a user to:

» Set up a Nios II project that specifies a desired hardware system and software program
* Download the Nios II hardware system onto an FPGA board

* Compile software programs, specified in assembly language or C, and download the resulting machine code
into the Nios II hardware system

* Disassemble and display the Nios II machine code stored in memory

* Run the Nios II processor, either continuously or by single-stepping instructions

* Examine and modify the contents of Nios II registers

* Examine and modify the contents of memory, as well as memory-mapped registers in I/O devices

* Set breakpoints that stop the execution of a program at a specified address, or when certain conditions are met
* Perform terminal input/output via a JTAG UART component in the Nios II hardware system

* Develop Nios II programs that make use of device driver functions provided through Altera’s Hardware Ab-
straction Layer (HAL)

The process of downloading and debugging a Nios II program requires the presence of an FPGA board to implement
the Nios II hardware system. In this tutorial it is assumed that the reader has access to the Altera DE2 Development
and Education board, connected to a computer that has Quartus II (version 9.1) and Nios II Embedded Design Suite
(EDS) software installed. Although a reader who does not have access to an FPGA board will not be able to execute
the Monitor Program commands described in the tutorial, it should still be possible to follow the discussion.
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The screen captures in this tutorial were obtained using version 5.0 of the Monitor Program; if other versions of the
software are used, some of the images may be slightly different.

1.1 Who Should use the Monitor Program

The Monitor Program is intended to be used in an educational environment by professors and students. The Monitor
Program is not intended for commercial use.

2 Installing the Monitor Program

The Monitor Program is released as part of Altera’s University Program Design Suite (UPDS). Before the UPDS can
be installed on a computer, it is necessary to first install Altera’s Quartus II CAD software (either the Web Edition
or Subscription Edition) and the Nios II Embedded Design Suite (EDS). This release (5.0) of the Monitor Program
can be used only with version 10.1 of the Quartus II software and Nios Il EDS. This software can be obtained from
the Download Center on Altera’s website at www.altera.com. To locate version 9.1 of the software for downloading,
it may be necessary to click on the item All Design Software in the section of the download page labeled Archives.
Once the Quartus II software and Nios II EDS are installed, then the Altera UPDS can be installed as follows:

1. Install the Altera UPDS from the University Program section of Altera’s website. It can be found by going to
www.altera.com and clicking on University Program under Training. Once in the University Program section,
use the navigation links on the page to select Educational Materials > Design Software > Altera Monitor
Program. Then click on the EXE item in the displayed table, which links to an installation program called
altera_upds_setup.exe. When prompted to Run or Save this file, select Run.

2. The first screen of the installer is shown in Figure 1. Click on the Next button.

B Altera University Program Design Suite Setup EI'E'E'

Welcome to the Altera University
Program Design Suite Setup Wizard

This wizard wil guide yau through the installation of the
alcera University Program Design Suite 5.0 (beta), Please
niote that vou must have previously installed a version of
Altera's Quartus IT software (wersion 10.1). The Altera
Monitor Program additionally requires the Altera's Mios 1T
Embedded Design Suite {version 10,1},

Figure 1. Altera UPDS Setup Program.
3. The installer will display the License Agreement; if you accept the terms of this agreement, then click | Agree
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to continue.

4. The next screen, shown in Figure 2, lists the components that will be installed, which include the Monitor
Program software and University Program IP Cores. The University Program IP Cores provide a number of
I/O device circuits that are used in Nios II hardware systems.

B Altera University Program Design Suite Setup

Y Choose Components

‘; Choose which features of Altera University Program Design Suite
wou wank to install,

Check the companents wou want to install and uncheck the components you don't wank ta
install, Click Install o skart the installation,

Select the type of install: v
Or, select the optional = Quarktus IT Material A
cDm:iIUnents you wish to #-[v] Simulation Tools
install:

Design Examples

=[] Nios IT Material
Altera Monitor Program
Mios [T Computer Systems
| - P

Drescription
Space required: 147.5MB

< Back ” Install I [ Cancel

Figure 2. The components that will be installed.

5. The installer is now ready to begin copying files. Click Install to proceed and then click Finish after the instal-
lation has been completed. If you answered Yes when prompted about placing a shortcut on your Windows

Desktop, then an icon Q is provided on the Desktop that can be used to start the Monitor Program.

6. Should an error occur during the installation procedure, a pop-up window will suggest the appropriate action.
Possible errors include:

* Quartus II software is not installed or the Quartus II version is incorrect (only version 10.1 is supported
by this release of the Monitor Program).

* Nios II EDS software is not installed or the version is incorrect (only version 10.1 is supported).

Note that if the Quartus II software is reinstalled at some future time, then it will be necessary to re-install the
Monitor Program at that time.

3 Main Features of the Monitor Program

Each Nios II software application that is developed with the Altera Monitor Program is called a project. The Monitor
Program works on one project at a time and keeps all information for that project in a single directory in the file
system. The first step is to create a directory to hold the project’s files. To store the design files for this tutorial, we
will use a directory named Monitor_Tutorial. The running example for this tutorial is a simple assembly language
program that controls some lights on a DE2 board.
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Start the Monitor Program software, either by double-clicking its icon on the Windows Desktop or by accessing the
program in the Windows Start menu under Altera > University Program > Monitor Program. You should see
a display similar to the one in Figure 3. This display consists of several windows that provide access to all of the
features of the Monitor Program, which the user selects with the computer mouse. Most of the commands provided
by the Monitor Program can be accessed by using a set of menus that are located below the title bar. For example,
in Figure 3 clicking the left mouse button on the File command opens the menu shown in Figure 4. Clicking the left
mouse button on the entry EXit exits from the Monitor Program. In most cases, whenever the mouse is used to select
something, the left button is used. Hence we will not normally specify which button to press.

+# Altera Monitor, Program [Nios I1]

File  Settings Actions Windows Help
HE B4R " ub it
Disassembly - | Registers - X
Goto instruction | Address (hex) or symbol name: | | @M
[ Dl
Disassembly j Breakpaints }'{ Memory )'{ \Watches )'{ Trace |
Terminal - | Info & Errors - X
Figure 3. The main Monitor Program display.
+ Altera Monitor Program ||
Settings  Actions  Wind
Mew Project. .. _[
Open Project, .. 7
Open Recent Project LN
Save Project 1
Exit
|
Figure 4. An example of the File menu.
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For some commands it is necessary to access two or more menus in sequence. We use the convention Menui >
Menu2 > ltem to indicate that to select the desired command the user should first click the mouse button on Menu1,
then within this menu click on Menu2, and then within Menu2 click on Item. For example, File > Exit uses the
mouse to exit from the system. Many commands can alternatively be invoked by clicking on an icon displayed in
the Monitor Program window. To see the command associated with an icon, position the mouse over the icon and a
tooltip will appear that displays the command name.

It is possible to modify the organization of the Monitor Program display in Figure 3 in many ways. Section 10 shows
how to move, resize, close, and open windows within the Monitor Program display.

3.1 Creating a Project

To start working on a Nios II software application we first have to create a new project, as follows:

1. Select File > New Project to open the New Project Wizard, as illustrated in Figure 5. This Wizard presents
a sequence of screens for defining a new project. Each screen includes a number of dialogs, as well as a
message area at the bottom of the window. The message area is used to display error and information messages
associated with the dialogs in the window. Double-clicking the mouse on an error message moves the cursor
into the dialog box that contains the source of the error.

+ New Project Wizard §|

Specify a project name and directory

Project directary:

|D:'|,M0nit0r_Tut0riaI | | Browse, ., |

Project name:

|M0nit0r_Tut0riaI| |

| < Back | | Mext = | | Einish | | Cancel |

Figure 5. Specifying the project directory and name.
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In Figure 5 we have specified the file system directory D:\Monitor_Tutorial and the project name Moni-
tor_Tutorial. For simplicity, we have used a project name that matches the directory name, but this is not
required.

The file system directory specified for the project must already exist. To select a directory by browsing through
the file system, click on the Browse button. Note that a given directory may contain at most one project.

. Click Next to advance to the window shown in Figure 6, which is used to specify a Nios II hardware system.
Nios II-based systems are described by a .ptf file, which is generated by the Altera SOPC Builder tool when
the system is created. More information about creating systems using SOPC Builder can be found in the
tutorial called Introduction to the Altera SOPC Builder, available in the University Program section of Altera’s
website. An optional .sof file, if specified, represents the FPGA circuit that implements the Nios II-based
system; this file can be downloaded into the FPGA chip on the board that is being used.

+ New Project Wizard §|

Specify a system

~Select a system

|DE2 Basic Computer v| [ Documentation ||

This system, called the DEZ2 Basic Computer, is intended to be used as a platform For introductory experiments in
computer organization and embedded syskems, To support these beginning experiments, the swstem contains only a
few components: a processor, memary, and some simple I/O peripherals,

~System details

System description (PTF) file:

|D.1'l,University_Pr0gram'l,NiosII_Computer_Systems'l,DE2'|,DE2_Basic_Computer'l,verilog'l,nios_system.ptf| | Browse. ., |

Quartus II programmriing (SOF) File (optional):

|zrsity_Program'l,NiosII_C0mputer_Systems'l,DEZ'l,DEZ_Basic_Computer'l,verilog'l,DEZ_Basic_Computer.sof| | Browse, ., |

The SOF file represents the FPGA programming File For the Mios II system, IF it is specified here, then the Manitor
Pragram can be used ta download this programming file onto the board. Otherwise, the svstem will need ko be
downloaded using some other method {for example, by using Quartus 11,

| < Back | | Mext = | | Einish | | Cancel |

Figure 6. Specifying the Nios II hardware system.

The drop-down list on the Select a system pane can be used to choose a pre-built Nios II computer system
provided with the Monitor Program, or a <Custom System> created by the user. Both the .ptf and the .sof
files are automatically filled in by the Monitor Program if a pre-built system is selected. However, if <Custom
Systems is selected, then the files need to be specified manually in the System details pane. Section 5 shows
how to use the Monitor Program with a Custom system.

As depicted in Figure 6, select the pre-built system named DE?2 Basic Computer. In the top right corner of
the screen there is a Documentation button. Clicking on this button opens a user guide that provides all
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information needed for developing Nios II programs for the DE2 Basic Computer, such as the memory map
for addressing all of the I/O devices in the system. This file can also be accessed at a later time by using the
command Settings > System Settings and then clicking on the Documentation button.

# New Project Wizard §|

Specify a program type

Program Type: |.¢\ssemb|y Prograrm v|

Lets wou specify a program written in assembly language.,

Include a sample program with the project

~select a ple program

ITAG UART
Interrupk Exaniple

Getting Started This program demonstrates use of parallel ports in the DEZ Basic Computer. E
Test Basic Computer

It performs the Following:

1. displays the SW switch values on the red LEDR

2. displays the KEY¥[3..1] pushbutton values on the green LEDG
3. displays a rotating pattern on the HEX displays

4. if KE¥[3..1] is pressed, uses the 5w switches as the pattern

| < Back | | Mext = | | Finish | | Cancel |

Figure 7. Selecting a program type and sample program.

3. Click Next to advance to the screen in Figure 7, which is used to specify the program source files that are
associated with the project. The Program Type drop-down list can be used to select one of the following
program types:

» Assembly Program: allows the Monitor Program to be used with Nios IT assembly language code
» C Program: allows the Monitor Program to be used with C code

» Program with Device Driver Support: this is an advanced option, which can be used to build programs
that make use of device driver software for the I/O devices in the Nios II hardware system. Programs
that use this option can be written in either assembly, C, or C++ language (or any combination). More
information about writing programs that use device drivers can be found in Section 9.

» ELF or SREC File: allows the Monitor Program to be used with a pre-compiled program, in ELF or
SREC format

* No Program: allows the Monitor Program to connect to the Nios II hardware system without first
loading a program
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For this example, set the program type to Assembly Program. When a pre-built Nios I computer system
has been selected for the project, as we did in Figure 6, it is possible to click on the selection Include a
sample program with the project. As illustrated in Figure 7 several sample assembly language programs
are available for the DE2 Basic Computer. For this tutorial select the program named Getting Started. Click
Next to advance to the screen in Figure 8. When a sample program has been selected, the source code
file(s) associated with this program are listed in the Source files box. In this case, the source file is named
getting_started.s; this source file will be copied into the directory used for the project by the Monitor Program.
If a sample program is not used, then it is necessary to click the Add button and browse to select the desired
source file(s).

Figure 8 shows that it is possible to specify the label in the assembly language program that identifies the first
instruction in the code. In the getting_started.s file, this label is called _start, as indicated in the figure.

# New Project Wizard g|

Specify program details

~Source files

First source file is used to determine the name of the binary program file.
D:\Monitor_Tutorial\getting_started.s Add...
Crawn
-Program options
Start symbol: | _start |

Source files highlighted in blue are sample program files, which will be created in the project directory,

| < B_ack| et =] | Einish | | Canicel |

Figure 8. Specifying source code files.

4. Click Next to advance to the window in Figure 9. This dialog is used to specify the connection to the FPGA
board, the Nios II processor that should be used (some hardware systems may contain multiple processors),
and the terminal device. The Host connection drop-down list contains the physical connection links (such
as cables) that exist between the host computer and any FPGA boards connected to it. The Nios II processors
available in the system are found in the Processor drop-down list, and all terminal devices connected to
the selected processor are displayed in the Terminal device drop-down list. We discuss terminal devices in
section 6.
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For this tutorial, accept the default values that are displayed in Figure 9.

# New Project Wizard E

Specify system parameters

-System parameters

Host connection: |USB-BIaster [Usg-0] v| | Refresh |

Processar: |CPU v|

Reset vector address: ]

Exception vector address: 0x20

Terminal device: |ITAG_UART -

| < B_ack| et =] | Finish | | Canicel |

Figure 9. Specifying system settings.

5. Click Next to reach the final screen for creating the new project, shown in Figure 10. This screen is used

to specify memory settings that are needed for compiling and linking the program. Nios II programs are
stored in a format that supports sections, which are used to divide a program into multiple parts, such as an
executable code section, called .text, and a data section, called .data. The partitioning of the program into
different sections is performed by the linker.

As illustrated in Figure 10, choose the SDRAM chip in the DE2 Basic Computer as the storage location for
both the .fext and .data sections, and use the value 0 for the offset into the memory for both sections. When
the offsets for both sections are identical the linker automatically places the .data section immediately after
the .rext section.

The getting_started.s file shows how to include .fext and .data directives in an assembly language program.
These directives should be included in a program when it is desirable to separate the program text and data.
For example, it may be desirable to place each section into a different memory device. Note that it is also
possible to use .org directives in an assembly language program to specify section addresses. However, this
approach can cause the machine code files generated by assembling the program to be very large if there is a
wide gap in addresses between the .text and .data sections.

For the sample program selected for this tutorial it is not necessary to make use of the .fext and .data sections.
However, other programs, such as those that use interrupts, must utilize these sections to avoid linking errors.
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10

x]

+ New Project Wizard

Specify program memory settings

~Processor's reset and exception vectors (read-only)
Reset vector address (hex): i}

Exception vector address (hex): 20

-Memory options

Here you can specify the starting addresses of sections identified by text and .data assembler directives, These
addresses can be in the same or in different memaries {on-chip, SDRAM, ...}, They can be used to ensure that the
.text and .data sections do not overlap with other sections, such as .reset and .exceptions, IF .text and .data are
specified to have the same address, the .data section will be placed right after the .text section by the linker,

r-text section

Memory device: |SDRAM,|’51 (0h - ZFFFFFRY v|

Start offset in device (hex): | D|
~.data section

Memary device: |SDRAM,|’51 (0h - FFFFFER) v|

Start offset in device (hex): | D|

| < Back | | Mk = | | Einish | | Canicel |

Figure 10. Specifying memory settings.

An example of the appropriate setting when interrupts are used in a program is given in section 8.

Click Finish to complete the creation of the new project. At this point, the Monitor Program displays the
prompt shown in Figure 11. Clicking Yes instructs the Monitor Program to attempt to download the Nios II
system associated with the project onto the FPGA board. It is also possible to download the system at a later
time by using the Monitor Program command Actions > Download SOPC Builder System.

3.1.1 Downloading a Nios Il Hardware System

When downloading a Nios II hardware system onto an FPGA board, it is important to consider the type of
license that is included in the hardware system for the processor. The Nios II processor uses a licensing
scheme that provides two modes of operation: 1. an evaluation mode that allows the processor to be used with
some restrictions when no license is present, and 2. a normal mode that allows unrestricted use when a license
is present. Nios II licenses can be purchased from Altera, and are also available on a donated basis through
the University Program. The prebuilt computer systems provided with the Monitor Program, such as the DE2
Basic Computer, include a Nios II processor that has a license. However, if other systems are being used with
the Monitor Program, then it is possible that a license is not present, and the Nios II processor may be used in
the evaluation mode. In this case it is necessary to use a different scheme, which is described in section 5, to
download the Nios II hardware system onto the FPGA board and activate the evaluation mode.
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Download SOPC Builder, System - Prompt

‘Would you like to download the system associated with this project onto the board?
H If =0, make sure that the board is connected via the correct cable and is powered up.

[ees || mo

Figure 11. Download the Nios II system.

3.2 Compiling and Loading the Program

After successfully creating a project, its software files can be assembled/compiled and downloaded onto the FPGA
board using the following commands:

» Actions > Compile menu item or o0 icon: compiles the source files into an ELF and SREC file. Build
warnings and errors will show up in the Info & Errors window. The generated ELF and SREC files are placed
in the project’s directory.

« Actions > Load menu item or ¥ icon: loads the compiled SREC file onto the board and begins a debugging
session in the Monitor Program. Loading progress messages are displayed in the Info & Errors window.

* Actions > Compile & Load menu item or 54 icon: performs the operations of both compilation and loading.

Our example project has not yet been compiled, so it cannot be loaded (the Load option is disabled). Click the Ac-

tions > Compile & Load menu item or click the £ icon to begin the compilation and loading process. Throughout
the process, messages are displayed in the Info & Errors window. The messages should resemble those shown in
Figure 12.

After successfully completing this step, the Monitor Program display should look similar to Figure 13. At this point,
the Nios II processor is halted at the first instruction of the program. The main part of the display in Figure 13 is
called the Disassembly window. We discuss this window in detail in section 3.4. It shows the source code of the
program, as well as a disassembled view of the corresponding Nios II machine code that is stored in memory. In the
figure, the first line of source code is the instruction movia r15, 0x10000040. This is a pseudo-instruction,
rather than a native Nios I instruction '. The Disassembly window shows immediately below this pseudo instruction
the corresponding Nios II machine code, which is stored at address 0. The movia operation is implemented by
using two Nios II machine instructions: orhi and addi. As illustrated in the figure, for each line of code from
the project’s assembly language source code files, the Monitor Program displays the source code along with its
corresponding disassembled machine code that is stored in memory. In most cases the source code and disassembled
machine code are the same, but for some operations, like pseudo instructions, they are different.

"More information about Nios II instructions and pseudo-instructions can be found in the tutorial Introduction to the Altera Nios Il Soft
Processor, available in the University Program section of Altera’s website.
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Info & Errors

|3 58

Info: (uartus IT Programmer was successful. 0 errors, 0 warnings
Info: Peak wirtual memory: 121 megabytes
Info: Processing ended: Fri Jan 14 15:11:59 2011
Info: Elapsed time: 00:00:02
Info: Total CPU time {on all processors): 00:00:00
Conpiling source files...
niosZ-elf-as --gstabs -I C:faltera/l0.l/niosZeds/componentssaltera niosZ ssdk/ine -I D:/Monicor_Tutorial Do /Mol
Linking...
ningZ-elf-1d --defsym nasys_program mem=0x0 --defaym nasys_data mem=0x0 --2ection-start .exceptions=0xi0 --ze
ELF generated at D:“Monitor Tutorial’getting started.elf.
ningZ-elf-objcopy -0 srec D:/Monitor_Tutorial /fgetting started.elf D:/Monitor_Tutorial/getting started.srec
SREC generated at D:hMonitor Tutorial’getting started.srec.
Uzing cable "USE-Elazter [UZE-0]", dewice 1, instance 0Ox00
Resetting and pausing target processor: 0OE
Reading Systen ID at address 0x100020Z20: werified
Initializing CPU cache (if present)
0E

Dovmloading 00000000 ( 0%)
Dowmloaded 1KE in 0.0s

Verifying 00000000 { 0%)

Werified 0K

Connection established to GDE serwver at localhost:2399
Symbols loaded.

Source code loaded.

Figure 12. Compilation and loading messages.

3.2.1 Compilation Errors

During the process of developing software, it is likely that compilation errors will be encountered. Error messages
from the Nios II assembler or from the C compiler are displayed in the Info & Errors window. To see an example of
a compiler error message, edit the file getting_started.s, which is in the project’s directory, and remove the : colon
that appears at the end of the _start label, in line 12. Recompile the project to see the error shown in Figure 14. The
error message gives the line number in the file (12) where the error was detected. Fix the error, and then compile
and load the program again.

3.3 Running the Program

As mentioned in the previous section, the Nios II processor is halted at the first instruction after the program has

been loaded. To run the program, click the Actions > Continue menu item or click the [l icon. The Getting
Started program performs the following actions on the DE2 board:

* Displays the DE2 board’s SW switch settings on the red lights LEDR

* Displays the KEY;, KEY>, and KEY3 pushbutton states on the green lights LEDG

» Shows a rotating pattern on the HEX displays. If KEY;, KEY>, or KEY3 is pressed, the pattern is changed to
correspond to the settings of the SW switches.
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# Altera Monitor Program [Nios 1] - Monitor_Tutorial. ncf : getting started.srec [Paused]

Disassembly Memary | Watches

Terminal

- X

Info & Errors

rls

File  Settings Actions Windows  Help
WE @¢E @00k i
Disassembly — ¥ | Registers - X
. . . " Reg Yalue
Golto |nstruct|on|Address (hex) or symbol name.| | - 1% 00000000| (B
.global _start | |lzero 0x 00000000
_Start: rl Ox 00000000
ra 000000000
/% initialize base addresses of parallel ports */ £3 0x 00000000
movia rl5, 0x10000040 /% W slider switch ba | |£2 0x00000000
_start: rs 000000000
0x00000000 030400734 orhi  rl5, zero, 0x1000 6 000000000
0x00000004  7he0ln04 addi  rl5, rl5, 0x40 7 L 00000000
novia rl6, 0x10000000 /% red LED base addreddl : gigggggggg
000000005 04040034 orhi rl6, zero, Ox1000 £lo 0x00000000
Ox0000000c §4000004 addi rla, rla, Ox0 rll 0%00000000
wnovia rl7, 0x10000050 /% pushbutton FEY basd rlz 0% 00000000
0x00000010 04440034 orhi  rl7, zero, 0x1000 i3 % 00000000
Ox0o000014 Gcd0ld0d addi rl7, rl7, O0xs0 rld 0x 00000000
wowvia rld, Oxl0000010 /% green LED base addy rls Ox 00000000
000000018 04540034 orhi rl8, zero, O0x1000 |l [rl6 Ox 00000000
- LESSES = — = o = = | (x17 000000000
rls 000000000

Ox 00000000 |

- X

[USE-0]", dewice 1, instance 0x00

Figure 13. The Monitor Program window after loading the program.

Info & Errors

JTAG UART link estahlished using cable "U3B-Elaster

Verified 0K

Connection established to GDE server
Aymbols loaded.

Source code loaded.

INFO: Program Trace not enabled, because trace requires

at localhost:2399

[+

Info & Errors | GDE Server |

Conmpiling source files...

niosi-elf-as --gstabs -I C:/faltera/l0.1/niosZeds/conponents/saltera niosZ/sdk/ine -I D: /Monitor_Tutorial D:/Moni
D:/Monitor_Tutorial /fgetting started.s:12: Error: unrecognised instruction _start
Compilation stopped.

[+

Info & Errors .' GDE Server .l

Figure 14. An example of a compiler error message.

The Continue command runs the program indefinitely. To force the program to halt, select the Actions > Stop

command, or click the 00 icon. This command causes the processor to halt at the instruction to be executed next,
and returns control to the Monitor Program. Another way to stop the execution of this program is to press the
pushbutton KEY on the DE2 board; this pushbutton is connected to the reset input of the Nios II processor in the
DE2 Basic Computer. Resetting the processor causes program execution to stop and sets the processor to its reset

address, which is address 0 in this system.
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Figure 15 shows an example of what the display may look like when the program is halted by using the Stop
command. The display highlights in yellow the next program instruction, which is at address 0x00000070, to be
executed, and highlights in red the register values in the Nios II processor that have changed since the last program
stoppage. Other screens in the Monitor Program are also updated, which will be described in later parts of this
tutorial.

# Altera Monitor Program [Nios I1] - Monitor_Tutorial. ncf : getting started.srec [Paused]

File  Settings Actions Windows Help

HE &¢E D0mdk f$

Disassembly - ¥ | Registers - X
- . , " Req Yalue
Goto |nstruct|on|nddress (hex) or symbol name.| | - 1x00000070| (B
HO_BUTTON: || [zexa Ox00000000
stwio r&, O(ra0) /% store to HEXI .. rl Ox 00000000
NO_EUTTON: rz Ox 00000000
000000058 stwio r6, 0(rz20) r3 0x00000000
stwin ra, 0i{rzl) J% store to HEXT . rd 0x00000150
000000060 stwio r6, 0(rzl) s 0x00000000
roli r6, e, 1 /% rotate the displawy ré D 00£00000
000000064 roli 16, r6, Oxl £ Dx0000Eh2e
ri 000000000
. )ﬁ r9 0x 00000000
wnovia r7, 100000 /% delay counter * rlo 0% 00000000
0= 00000065 orhi r?, zero, Oxi rll 0%00000000
Ox0000006c addi r7, r7, -0x7960 rlz 0% 00000000
rl3 Ox 00000000
DELAY: rld 0x00000000
aubi il 7, 1 rls 0x 10000040
DELAT: rle Ox 10000000
000000070 addi r?, 7, -0xl —| |17 Ox 10000050
A T e1a 0x10000010
rls Ox0000007c
Disassembly | Breakpoinks / Memory [ ‘Watches rzo oxl00000z0 [«
Terminal - | Info & Errors - X

JTAG UART link established using cable "U3B-Blaster Symbols loaded.

[USE-0]", dewice 1, instance 0x00 Source code loaded.

INFO: Program Trace not enahled, because trace redquires
Program stopped @ 0x00000070

[+

Info & Errars [ GDE Server |

Figure 15. The Monitor Program display after the program has been stopped.

3.4 Using the Disassembly Window

In Figure 15 the Disassembly window shows six machine instructions, at the memory addresses 0x0000005c,
0x00000060, 0x00000064, 0x00000068, 0x0000006¢c, and 0x00000070. The leftmost column in the
window gives the memory addresses, the middle column displays the machine code at that address, and the rightmost
column shows both the original source code for the instruction, in a brown color, and the disassembled view of the
machine code that is stored in memory, in a green color. As shown in the figure, the program may be implemented
with different instructions from those given in the source code. For example subi r7, r7, 1 isimplementedin
this program by using addi r7, r7, -1.

The Disassembly window can be configured to display less information on the screen, such as not showing the source
code from the .s assembly language file or not showing the machine encoding of the instructions. These settings
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can be changed by right-clicking on the Disassembly window and selecting the appropriate menu item, as shown in
Figure 16. The color scheme used in the Disassembly window is given in Table 1.

000000070 Al L} 2 rue

v Show instruction words

0x00000074

Goka inskruction, .,

Figure 16. Pop-up menu to configure the display of the Disassembly window.

Color Description
Brown | Source code
Green Disassembled instruction name
Blue Registers
Orange | Immediate & offset values
Dark blue | Address values & labels
Purple Clickable link
Gray Machine encoding of the instruction

Table 1. Disassembly window color scheme.

Different regions of memory can be disassembled and displayed by scrolling, using either the vertical scrollbar on
the right side of the Disassembly window or a mouse scroll wheel. It is also possible to scroll the display to a
region of memory by using the Goto instruction panel at the top of the Disassembly window, or using the command
Actions > Goto instruction. The instruction address provided for the Goto command must be a multiple of four,
because Nios II instructions are word-aligned. As an example, enter the label DELAY or the address 70, and press
Go. The Disassembly window scrolls to the address 0x00000070, as depicted in Figure 17, and highlights the
instruction using a pink color.

Register and memory values can be examined in the Disassembly window while the Nios II processor is halted.
This is done by hovering the mouse over a register or register + offset name for an instruction in the window, as
illustrated in Figure 18. If the instruction loads or stores a value from/to memory, then the Monitor Program displays
the current value of the memory location in the pop-up.

The Disassembly window also produces clickable links in its display of branch and call instructions. Clicking
on one of these links scrolls the display to show the target instruction of the branch or call. Figure 19 shows an
example of a clickable link for a call instruction.

The Disassembly window attempts to show disassembled code for all words in memory, even though some memory
words may not corresponds to Nios II executable code. For example, in Figure 17 the memory word at address
0x0000007C has the value 0x0000000f and represents data that is used by the program. Even though the
Disassembly window attempts to show a corresponding Nios II assembly language instruction for this memory
word, the disassembled machine code is not meaningful because this data does not represent executable code.
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+ Altera Monitor, Program [Nios II] - Monitor_Tutorial. ncf : getting started.srec [Paused]

File  Settings Actions Windows  Help

HE B¢ E D0 ml @

Disassembly — ¥ | Registers - X
. . . " Reg Yalue
Golto |nstruct|on|Address (hex) or symbol name: |DELAY | - 1% 00000000| (B
| |lzero 0x 00000000
DELLY: rl Ox 00000000
subi 7, r7, 1 ra Ox 00000000
DELLY: r3 Ox 00000000
0x 00000070 addi  r7, r7, -Oxl rd 0:x00000000
bne £7, 0, DELAY 3 Dx00D0000D
0x00000074 bne £7, zero, -Oxg (0x00000070: DELAY) ré 0x00000000
r7 Ox 00000000
ri 000000000
br DO_DISPLAY ro 000000000
000000075 br —0xd0 (0x0000003c: DO_DISPLAY) £lo 0x00000000
rll 000000000
HEX bita: rlz 0% 00000000
00000007 1dh zero, O{zern) rl3 000000000
Ox 00000050 heqg rd, zero, Ox& [(0x0000005c) rld 0x 00000000
Ox00000054 call 0x0000003k (Ox000000ec) rls Ox 00000000
000000088 br Qe (Ox00000098) rle Ox 00000000
Ox0000005c stw ea, TZ(sp) —| |17 000000000
FaeOOOAAAGS 2 ctu 2 = e1s 0% 00000000
K AN 0x00000000
Disassembly / Breakpoints /'{ Memary /'{ Watches /'{ Trace | rzo 0x00000000 |
Terminal = # | Info & Errors - X
JTAG UART link established using cable "USE-Blaster Comnection established to GDE server at localhost:239s  |[=
[USE-0]", dewice 1, instance 0x00 Symbols loaded.
Source code loaded.

INFO: Program Trace not enabled, because trace requires

[+

Info & Errors | GDE Server |

Figure 17. Goto instruction panel in the Disassembly window.

novia r18, HEX hits r5 £x00000000

0x 00000030 orhi rld, zero, Ox0 ] 0x0000100
0x00000034 addi rld, rld, Ox7c i; Eiggg;;g;g
1duwr ra, 0(rla) /% load pattern for }ﬁ o 0%00000000

000000038 law 6, 1193 rin 0x00000000
0x0000007c: 0x0000000F ril £x00000000

rlz 0x00000000

DO_DISPLAY: rl3 0x00000000

ldwio rd, 0(rls) /% load slider aswif rld 0x00000000

DO_DISPLAY: rl5 0x10000040

0x0000003¢ ldwio r4, 0{rl5) rlé 0x10000000

Figure 18. Examining a register value in the Disassembly window.

3.5 Single Stepping Program Instructions

Before discussing the single step operation, it is convenient to restart execution of the Getting Started program from

the beginning. Click the Actions > Restart menu item or click the a, icon to restart the program. Note that if the
program is running, it must first be halted before the restart command can be performed.

The Monitor Program has the ability to perform single-step operations. Each single step consists of executing a
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display:
call UPDATE HEX DISPLAYT
display:
0x00001028 call Ox0000046¢ %XDDDDllbD: UPDATE_HEX DISPLAY)

4 delay loop of appdGobo instruction label 'UPDATE_HEx_DISPLAY' (0x00001 16}

Figure 19. A clickable link in the Disassembly window.

single Nios II machine instruction and then returning control to the Monitor Program. If the source code of the
program being debugged is written in C, each individual single-step will still correspond to one assembly language
(machine) instruction generated from the C code.

The single-step operation is invoked by selecting the Actions > Single step menu item or by clicking on the o
icon. The instruction that is executed by the processor is the one highlighted in the Disassembly window before
the single step.

Since the first step in this section was to restart the program, the first single step will execute the instruction at
address 0, which will set the upper bits of the Nios II register r15 to the value 0x1000. Subsequent single steps will
continue to execute one instruction at a time, in sequential order. Single stepping at a branch instruction may jump
to a non-sequential instruction address if the branch is taken. This behavior can be observed by single stepping to
the address 0x0000004c, which is a beq instruction. Single stepping at this instruction will set the pc value to
0x0000005c, which is the location of the instruction executed at this point in the Getting Started program when
no pushbutton KEY is being pressed on the DE2 board.

Another way to perform the single-step operation is to use the Step Over Subroutine command in the Actions
menu. This command performs a normal single step, unless the current instruction is a call instruction. In this case
the program will run until the called subroutine is completed.

3.6 Using Breakpoints

An instruction breakpoint provides a means of stopping a Nios II program when it reaches a specific address. A
simple procedure for setting an instruction breakpoint is:

1. In the Disassembly window, scroll to display the instruction address that will have the breakpoint. As an
example, scroll to the instruction at the label NO_BUTTON, which is address 0x0000005c.

2. Click on the gray bar to the left of the address 0000005¢ in the Disassembly window. As illustrated in
Figure 20 the Monitor Program displays a red dot next to the address to show that an instruction breakpoint
has been set. Clicking the same location again removes the breakpoint.

Once the instruction breakpoint has been set, run the program. The breakpoint will trigger when the pc register value
equals 0x0000005c. Control then returns to the Monitor Program, and the Disassembly window highlights in a
yellow color the instruction at the breakpoint. A corresponding message is shown in the Info & Errors pane.
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+ Altera Monitor, Program [Nios II] - Monitor_Tutorial. ncf : getting started.srec [Paused]

File  Settings Actions Windows  Help
HE &¢E 2lk 2§
Disassembly — ¥ | Registers - X
. . . " Reg Yalue
Golto |nstruct|on|Address (hex) or symbol name.|5c: | - 0% 00000000| [
4] |zezo 0x00000000
rl Ox 00000000
N0 BUTTON: rz Ox 00000000
atwio r6, 0{rz0) /% store to HEXI .. r3 000000000
HO_EUTTON: rd 000000150
@0:0000005¢ stwio  r6, 0(r20) L5 0x00000000
stuio r&, 0(rzl) /% store to HEX7T . 6 0x0000000£
0% 00000060 stwio  r6, 0({rzl) E; gigggé;g;g
rol? rh, r6, 1 /% rotate the dlsplayﬁ 9 0x00000000
000000064 roli r6, rh, Oxl £lo 0x00000000
rll 000000000
wnovia r7, 100000 /% delay counter * rlz 0% 00000000
O0x00000065 orhi r7, zero, Oxz rl3 000000000
Ox0000006c addi 7, 7, -0x7960 rld 0x 00000000
rls 010000040
DELLY: rle Ox 10000000
subi r7, 7, 1 —| |17 010000050
= le1s 0% 10000010
rld 0x 0000007
Disassembly / Breakpoinks | Memary [ ‘Watches rzo 0x 10000020 |+
Terminal = # | Info & Errors - X
JTAG UART link established using cable "USE-Elaster Source code loaded. -
[USE-0]", dewvice 1, instance 0x00 INFO: Program Trace not enabled, because trace requires
Program stopped @ 0x00000070
BREAK: Program break @ 0x0000005c
[+
Info & Errors | GDE Server |

Figure 20. Setting an instruction breakpoint.

Some versions of the Nios II processor support other types of breakpoints in addition to instruction breakpoints.
Other types of breakpoints are described Appendix A of this document.

3.7 Examining and Changing Register Values

The Registers window on the right-hand side of the Monitor Program display shows the value of each register in
the Nios II processor and allows the user to edit most of the register values. The number format of the register values
can be changed by right-clicking in the Registers window, as illustrated in Figure 21.

Each time program execution is halted, the Monitor Program updates the register values and highlights any changes
in red. The user can also edit the register values while the program is halted. Any edits made are visible to the
Nios II processor when the program’s execution is resumed.

As an example of editing a register value, first scroll the Disassembly window to the label DELAY, which is at
address 0x00000074. Set a breakpoint at this address and then run the program. After the breakpoint triggers and
control returns to the Monitor Program, notice that there is a large value in register r7. This value is used as a counter
in the delay loop. As indicated in Figure 22, double-click on the contents of register r7 and edit it to the value 1.
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Registers -
Reg Walue
nc 000000000 | &
ZErO 0x00000000
rl Ox00000000
rZ 0x00000000
r3 Ox00000000
rd Ox00000180
rs Ox00000000

Binary
Octal

Decimal

Signed representation

rl3 Ox00000000
rld 0x00000000
rls Ox10000040
rlé 0x 10000000
rl7 Ox10000050
rld 0x10000010
rls O0x0000007¢
rai 0x 10000020 |+

Figure 21. Setting the number format for displaying register values.

Press Enter on the computer keyboard, or click away from the register value to apply the edit. Now, single-step the
program to see that it exits from the delay loop after one more iteration, when r7 becomes 0.

DELAY: rl 0xD0000000
subi 7, €7, 1 rz DxD0000000

DELAY: r3 DxD0000000

0x00000070 addi 7, £7, -Oxl rd 0x00000150
bre £7, r0, DELAY s 0=00000000

@ 0x00000074 bre r7, zero, -0x8 (0x00000070: DELAT) i DxD0no00 Le
8 0xD0000000

br DO_PISPLAY 9 DxD00000D0

0xDO0D00TS br 040 {0x0000003c: DO_DISPLAY) z20 1%00000000

Figure 22. Editing a register value.

3.8 Examining and Changing Memory Contents

The Memory window, depicted in Figure 23, displays the contents of the system’s memory space and allows the
user to edit memory values. The leftmost column in the window gives a memory address, and the numbers at the
top of the window represent hexadecimal address offsets from that corresponding address. For example, referring to
Figure 23, the address of the last word in the second row is 0x00000010 + Oxc = 0x0000001lc.

If a Nios II program is running, the data values displayed in the Memory window are not updated. When the program
is stopped the data can be updated by pressing the Refresh Memory button. By default, the Memory window
shows only the contents of memory devices, and does not display any values from memory-mapped I/O devices. To
configure the window to display memory-mapped I/O, click on the check mark beside Query All Devices, and then
click Refresh Memory.

The color of a memory word displayed depends on whether that memory location corresponds to an actual memory
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+ Altera Monitor, Program [Nios II] - Monitor_Tutorial. ncf : getting started.srec [Paused]

File  Settings Actions Windows  Help

HE B¢ E D0 ml @

Memory — ¥ | Registers - X
X X - Reg alue
Goto memory address | Address (hex): | || [] Query &l Devices - Ix0000003c| (B
4] |zezo 0x00000000
0x00000000 03040034 7hoOl004 04040034 84000004 rl 0x00000000
0x00000010 04440034  5c401404 04840034 94800404 rz 000000000
0x00000020 05040034  aS000804 05440034  ad400c04 r3 000000000
0x00000030 04000034 9cc0lf04 99800017 79000037 rd 0x00000180
0x00000040  B1000035 89400037 91400035 28000326 5 0x00000000
0x00000050  2004883a 89400037  283ffele  al@00035 UXUUUDUME

000000060 af500035 300cl07a 0lcO00b4 39elatiod
000000070 I9ffffed 383ffele no3£f£o0e noooooot
000000080 Z0000zz28 00000ecO ooooosoe df401z15

i Ox 00000000
9 Ox 00000000

rl0 Ox 00000000
Ox00000090 eSbhEfEF17 003dal3a 49401117 df401217 rll 0%00000000
Ox000000a0 dfc000L1? Z801707a d5400217 dg800317 rlz 0x 00000000
O0x000000b0  dSc00417 42000517 d9400817 49800717 rls Ox00000000
0x000000cO  d9c00817  dad00sl?  dad00al?  dagoobl? rid 0%00000000
Q00000040 dac00cl? dh0oodl? db400el? dba00£17 rls 0x 10000040
00000000 dbe0Ll0Ll7?  dec01304 ef80083a defffdid rlé Ox 10000000
Ox000000£0 dfcO0zZ15 de00olls dc400015 0009313a —| |17 010000050
faeAOAAalOn  AA0A06Ad AAAGAATA AnA ook hd| | YN 0x 10000010
K AN 0x0000007¢
Disassembly f'{ Breakpoints | Memory f Watches /'{ Trace | rzo 0x 10000020 |+
Terminal = # | Info & Errors - X
JTAG UART link established using cable "USE-Elaster Program stopped @ 0x00000070 -
[USE-0]", dewvice 1, instance 0x00 BREAK: Program break [ 0x0000005c
BREAK: Program break [ 0x0000005c

BREAK: Program break @ 0x00000074

[+

Info & Errors | GDE Server |

Figure 23. The Memory window.

device, a memory-mapped I/O device, or is not mapped at all in the system. A memory location that corresponds to
a memory device will be colored black, memory-mapped I/O is shown in a blue color, and a non-mapped address is
shown in grey. If a memory location changed value since it was previously displayed, then that memory location is
shown in a red color.

Similar to the Disassembly window, it is possible to view different memory regions by scrolling using the vertical
scroll bar on the right, or by using a mouse scroll wheel. There is also a Goto memory address panel, which is
analogous to the Goto instruction window discussed in section 3.4. Click to turn on the check mark beside Query
All Devices in the memory window. In the Goto memory address panel type the address 0x10000000, and
then press Go. The display scrolls to the requested address, which corresponds to memory-mapped I/O devices in
the DE2 Basic Computer. Click the Refresh Memory button. The data displayed in blue at address 0x10000040
corresponds to the settings of the 18 SW switches on the DE2 board. Experiment with different SW switch settings
and press Refresh Memory to see that the switch values are properly displayed.

As an example of editing a memory value, double-click on the memory word at address 0x10000000 and type
the hexadecimal data value 15555. Press Enter on the computer keyboard, or click away from the memory word to
apply the edit. This memory-mapped address in the DE2 Basic Computer corresponds to the red lights LEDR on the
DE2 board. Experiment by editing this memory location to different values and observe the LEDs.
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It is possible to change the appearance of the Memory window in a number of ways, such as displaying data as bytes,
half-words, or words, and so on. The Memory window provides additional features that are described in more detail
in the Appendix A of this document.

4 Working with Project Files

Project files store the settings for a particular project, such as the specification of a hardware system and program
source files. A project file, which has the filename extension ncf, is stored into a project’s directory when the project
is created.

The Monitor Program provides the following commands, under the File menu, for working with project files:

1. New Project: Presents a series of screens that are used to create a new project.
2. Open Project: Displays a dialog to select an existing project file and loads the project.

3. Open Recent Project: This command displays the five most recently-used project files, and allows these
projects to be reopened.

4. Save Project: Saves the current project’s settings. This command can be used to save a project’s settings
after they have been modified by using the Settings command, which is described below.

4.1 Modifying the Settings of an Existing Project

After a project has been created, it is possible to modify many of its settings, if needed. This can be done by clicking

on the menu item Settings > System Settings in the Monitor Program, or the £ icon. This action will display
the existing System Settings for the project, and allow them to be changed. Similarly, the program settings for the

project can be displayed or modified by using the command Settings > Program Settings, or the L= icon. The
change these settings, the Monitor Program has to first be disconnected from the system being debugged. This can
be done by using the command Actions > Disconnect.

5 Using the Monitor Program with a Nios Il Evaluation License

In our discussion of Figure 11, in section 3.1, we showed how the Monitor Program can be used to download a
prebuilt Nios II hardware system onto an FPGA board, when the Nios II processor has a license. It is also possible
to use the Monitor Program to debug hardware systems in which the Nios II processor includes only an evaluation
license. In this case it is necessary to download the hardware system onto the FPGA board by using the Programmer
tool provided in the Quartus II software, rather than using the Monitor Program for this purpose. The Quartus II
Programmer tool provides a pop-up window, shown in Figure 24, that indicates activation of the evaluation license
for the Nios II processor. This pop-up window has to remain open in order to maintain the evaluation license for
Nios II. As long as the pop-up window remains open, the Monitor Program can be used to compile and download
software programs into the hardware system.
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OpenCore Plus Status

Click Cancel ta stop uging DOpenCore Plus IF.

Time remaining: unlimited

Cancel

Figure 24. The Quartus II Programmer pop-up window.

6 Using the Terminal Window

This section of the tutorial demonstrates the functionality of the Monitor Program’s Terminal window, which sup-
ports text-based input and output. For this example, create a new Monitor Program project for the DE2 board, called
Monitor_Terminal. Store the project in a directory of your choice.

When creating the project, follow the same steps shown for the Monitor_Tutorial project, which were illustrated
in Figures 5 to 10. For the screen shown in Figure 7 set the program type to Assembly Program, and select the
sample program named JTAG UART. The source code file that will be displayed in the screen of Figure 8 is called
JTAG_UART.s. It communicates using memory-mapped I/O with the JTAG_UART in the DE2 Basic Computer that
is selected as the Terminal device in the screen of Figure 9.

Compile and load the program by following the procedure in section 3.2. Then, run the program using the steps
in section 3.3. The Monitor Program window should appear as shown in Figure 25. Notice that the Terminal
window displays a text prompt which is sent by the JTAG_UART.s program. Click the mouse inside the Terminal
window. Now, any characters typed on the computer keyboard are sent by the Monitor Program to the JTAG UART.
These characters are shown in the Terminal window as they are typed, because the JTAG_UART.s program echos the
characters back to the Terminal window.

The Terminal window supports a subset of the control character commands used for a de facto standard terminal,
called the VT100. The supported commands are listed in Table 2. In this table <ESC> represents the ASCII character
with the code 0x1B.

7 Using C Programs

C programs are used with the Monitor Program in a similar way as assembly language programs. To see an example
of a C program, create a new Monitor Program project for the DE2 board, called Monitor_Terminal_C. Store the
project in a directory of your choice. Use the same settings as for the Monitor_Terminal example, but set the program
type for this project to C Program. Select the C sample program called JTAG UART. As illustrated in 26 this sample
program includes a C source file named JTAG_UART.c; it has identical functionality to the assembly language code
used in the previous example. Compile and run the program to observe its behavior.

The C code in JTAG_UART.c uses memory-mapped I/O to communicate with the JTAG UART. Alternatively, it is
possible to use functions from the standard C library stdio.h, such as putchar, printf, getchar, and scanf for this
purpose. Using these library functions impacts the size of the Nios II executable code that is produced when the C
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# Altera Monitor, Program [Nios II] - Monitor_Tutorial. ncf : JTAG_UART.srec [Running]

File  Settings Actions Windows  Help

HE G ¢E 0 1§

Disassembly — ¥ | Registers - X
. . . " Reg Yalue
Golto |nstruct|on|Address (hex) or symbol name: |DELAY | - aooooon0| [
LLext /% executable codz Zero 0x00000000
.global _atart rl Ox 00000000
start: rz 0x00000000
/% get up stack pointer %/ r3 0x00000000
navia sp, OxO0TFFFFC /% starts from largesy || [E% 0xa000a000
atart: rs 0x00000000
0x00000000 " orhi ap, zero, 0x&0 6 0x@000a000
0x00000004 addi  sp, sp, -0x4 7 0:x00000000

i Ox 00000000

9 Ox 00000000

movia r&, 0x10001000 /% JTAG UART base g rlo 000000000
O0x 00000008 orhi r6, zero, 0x1000 rll 0%00000000
Ox0000000c addi r6, rf, O0x1000 rlz 0x 00000000
rl3 Ox 00000000
/% print a text string ¥/ rld 0x00000000
movia r&, TEXT_ 3TRING rls 0x 00000000
Ox00000010 orhi r8, zero, 0Ox0 rlé Ox 00000000
000000014 addi rd, ri, Oxad —| |17 000000000
T e1a 0% 00000000
rla Ox 00000000
Disassembly / Breakpoinks | Memary [ ‘Watches rzo 0x00000000 |
Terminal = # | Info & Errors - X
JTAG UART link established using cable "USB-Elaster |||Verified 0K -
[USB-01", dewice 1, instance 0x00 Connection established to GDE serwver at localhost:2399
Symbols loaded.
JTAG UART example code dource code loaded.
- INFO: Program Trace not enabled, because trace requires
[+

Figure 25. Using the Terminal window.

program is compiled, by about 30 to 64 KBytes, depending on which functions are needed. It is possible to minimize
the size of the code generated for this library by checking the box labeled Use small C library in Figure 26. When
this option is used the library has reduced functionality. Some limitations of the small C library include: no floating-
point support in the output routines, such as printf, and no support for input routines, such as scanf and getchar.

In Figure 26 the option Emulate unimplemented instructions is checked. This option causes the C compiler to
include code for emulating any operations that are needed to execute the C program but which are not supported by
the processor. For example, the Nios II Economy version does not include a multiply instruction, but the C program
may need to perform this operation. By checking this option, a multiply instruction will be implemented in software
(by using addition and shift operations).

8 Using the Monitor Program with Interrupts

The Monitor Program supports the use of interrupts in Nios II programs. Two example of interrupts are illustrated
below, using assembly language code and using C code.
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Character Sequence | Description

<ESC>[2J Erases everything in the Terminal window

<ESC>[7h Enable line wrap mode

<ESC>[71 Disable line wrap mode

<ESC>[#A Move cursor up by # rows or by one row if # is not specified

<ESC>[#B Move cursor down by # rows or by one row if # is not specified

<ESC>[#C Move cursor right by # columns or by one column if # is not spec-
ified

<ESC>[#D Move cursor left by # columns or by one column if # is not speci-
fied

<ESC> [#1;#2L Move the cursor to row #; and column #;

<ESC>[H Move the cursor to the home position (row 0 and column 0)

<ESC>[s Save the current cursor position

<ESC>[u Restore the cursor to the previously saved position

<ESC>[7 Same as <ESC> [ s

<ESC>[8 Same as <ESC> [u

<ESC>[K Erase from current cursor position to the end of the line

<ESC>[1K Erase from current cursor position to the start of the line

<ESC>[2K Erase entire line

<ESC>[J Erase from current line to the bottom of the screen

<ESC>[2J Erase from current cursor position to the top of the screen

<ESC>[6n Queries the cursor position. A reply is sent back in the format
<ESC> [#;; #2R, corresponding to row #; and column #,.

Table 2. VT100 commands supported by the Terminal window.

8.1 Interrupts with Assembly Language Programs

To see an example using interrupts with assembly language code, create a new Monitor Program project called
Monitor_Interrupts. When creating the new project set the program type to assembly language and select the sample
program named Interrupt Example. Figure 27 lists the source files for this sample program. The main program for
the example is the file interrupt_example.s, which initializes some I/O devices and enables Nios II interrupts. The
other source files provide the reset and exception handling for the program, and two interrupt service routines.
Figure 28 shows the offset values for the fext and data sections that should be used for this program. These offsets
cannot be 0 because the reset vector of the Nios II processor in the system being used is at address 0x0 and the
exception vector is at address 0x20. Enough space has to be left between the exception vector and the text section
of the program to accommodate the exceptions processing code, which corresponds to the assembly language code
in the file exception_handler.s. The offset value 0x4 00, as shown in the figure, is large enough to accommodate the
exceptions code.

Compile and load the program. Then, scroll the Disassembly window to the label EXCEPTION_HANDLER, which
is at address 0x00000020. This address corresponds to the exception vector address for the Nios II processor in
the DE2 Basic Computer. As illustrated in Figure 29, set a breakpoint at this address. Run the program. When the
breakpoint is reached, single step the program a few more instructions to determine the cause of the interrupt. The
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+ New Project Wizard g|
Specify program details
~Source files
First source file is used to determine the name of the binary program fFile,
C:iMonitor_Terminal _CWITAG_UART.c Add...
Crown
-Program options
Additional compiler flags: |-01 -ffunction-sections -Fverbose-asm -fro-inline |
Additional linker Flags: | |
[ Use small C library Emulate unimplemented instructions

Source files highlighted in blue are sample program files, which will be created in the project directory,

| < B_ack| bt = | Finish | | Canicel |

Figure 26. Specifying settings for a C program.

source of the interrupt is a device in the DE2 Basic Computer called the inferval timer. This device provides the
ability to generate an interrupt whenever a specific time period elapses. Single step the program until the Nios II
processor enters the interrupt service routine for the interval timer. This routine first clears the timer register that
caused the interrupt, so that it won’t immediately occur again, and then performs other functions needed for the
program.

Finally, remove the breakpoint that was set earlier, at address 0x00000020, and then select the Continue command
to run the program. Observe that the program displays a rotating pattern across the HEX displays on the DE2 board.
The direction of rotation can be changed by pressing the pushbuttons KEY; or KEY, on the DE2 board, and the
pattern can be changed to correspond to the values of the SW switches by pressing KEY3. Pressing KEY causes a
reset of the Nios II processor and returns control to the Monitor Program at the address 0xO0.

8.2 Interrupts with C Programs

To see an example of a C program that uses interrupts, create a new project called Monitor_Interrupts_C. When
creating this project, set the program type to C Program and select the sample program named Interrupt Example;
this program gives C code that performs the same operations as the assembly language code in the previous example.
The source files for the C code are listed in Figure 30. The main program is given in the file interrupt_example.c,
and the other source files provide the reset and exception handling for the C program, as well as two interrupt service
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+ New Project Wizard PZ|
Specify program details
~Source files
First source file is used to determine the name of the binary program fFile,
[:iMonibor_Program_TutorialsiMonitor _Inkerruptsiinkerropt_example.s Add...
[:\Monitor_Program_TutorialsiMonitar_Inkerrupts\exception_handler.s
Cr:iMonitor_Program_TutorialsiMonitor _Inkerruptstinkerval _timer.s
[:\Monitor_Prograrm_Tutorials\Maonitor _Inkerrupts\pushbutton_ISR.s
Drawn
-Program options
Start symbol: | _start |
Source files highlighted in blue are sample program files, which will be created in the project directory,
| < B_ack| bt = | Finish | | Canicel |

Figure 27. The source files for the interrupt example.

routines. Complete the steps for creating the project, and then compile and load it.

Set a breakpoint at the address 0x00000020, which is the exception vector address for the Nios II processor. Also,
scroll the Disassembly window to the function called interrupt_handler, which is at address 0x00000698. As
illustrated in Figure 31, set another breakpoint at this address. Now, run the program to reach the first breakpoint, at
address 0x00000020. The code at this address, which is found in the file exception_handler.c, reads the contents
of a control register in the Nios II processor to determine if the interrupt is caused by an external device, then saves
registers on the stack, and then calls the interrupt_handler function.

Press Actions > Continue in the Monitor Program to reach the second breakpoint. Single stepping the program
a few more instructions shows that the interrupt is caused by the interval timer in the DE2 Basic Computer, as
discussed in the previous example. Additional single stepping causes the Nios II processor to enter the interrupt
service routine for the interval timer, as depicted in Figure 32. This routine first clears the timer register that caused
the interrupt, and then performs other functions needed for the program. Finally, clear both breakpoints that were
set earlier, at addresses 0x00000020 and 0x00000698, and then run the program; it displays a rotating pattern
on the HEX displays of the DE2 board, as discussed in the previous example.
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x]

+ New Project Wizard

Specify program memory settings

~Processor's reset and exception vectors (read-only)
Reset vector address (hex): i}

Exception vector address (hex): 20

-Memory options

Here you can specify the starting addresses of sections identified by text and .data assembler directives, These
addresses can be in the same or in different memaries {on-chip, SDRAM, ...}, They can be used to ensure that the
.text and .data sections do not overlap with other sections, such as .reset and .exceptions, IF .text and .data are
specified to have the same address, the .data section will be placed right after the .text section by the linker,

r-text section

Memory device: |SDRAM,|’51 (0h - ZFFFFFRY v|

Start offset in device (hex): | 4DD|
~.data section

Memary device: |SDRAM,|’51 (0h - FFFFFER) v|

Start offset in device (hex): | 4DD|

| < Back | | Mk = | | Einish | | Canicel |

Figure 28. Memory offset settings for the interrupt example.

9 Using Device Drivers (Advanced)

Altera’s development environment for Nios II programs provides a facility for using device driver functions for the
I/O devices in a hardware system. This facility, which is called the hardware abstraction layer (HAL), is supported
by the Monitor Program. Using device driver functions is not recommended for beginning students, and is intended
for more advanced users.

To see an example of code that uses device driver functions create a project called Monitor_HAL. For this project
select the prebuilt system named DE2 Media Computer; this is a hardware system that provides more features than
the DE2 Basic Computer that was used in previous examples. Set the program type to Program with Device
Driver Support, and select the sample program named Media. The source file for this sample program is called
media_HAL.c. When creating this project, the New Project Wizard does not display the screen for choosing memory
settings, such as the one in Figure 28. This is because the HAL automatically chooses the necessary memory settings
for projects that make use of device drivers.

The media_HAL program communicates with I/O devices by making calls to device driver functions, rather than
using memory-mapped I/O as has been done in previous examples in this tutorial. To see some examples of such
function-calls, examine the source code in the file media_HAL.c. It calls device driver functions for the audio devices
in the DE2 Media Computer, the 16 X 2 character display, the VGA output port, the PS/2 port, and parallel ports.
The device driver functions for each of these devices are defined in include files that are specified at the top of the
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# Altera Monitor, Program [Nios II] - Monitor_Interrupts.ncf : interrupt_example.srec [Paused]

File  Settings Actions Windows  Help
WE @¢E @00k i
Disassembly — ¥ | Registers - X
Golto instruction|Address (hex) or symbol name: |EXCEPTIDN_H.ANDLER | iz H D;EEE&SD
— || [pc by -
EXCEFTION_HANDLER: | |lzero 000000000
@ 000000020 addi  sp, sp, -0xl0 rl 00000000
0x 00000024 stw et, O{ap) ra 0x 00000000
0x00000025 rdctl  et, ipending r3 0x@000a000
0x 00000028 beq et, zero, Oxd (0x00000034: SKIP_EA _DEC) rd 0:x00000000
0x00000030 addi  ea, ea, -0x4 L5 0x00000000
ré 000000000
SKIP E4 DEC: r7 Ox00000001
— = 3 0x00000000
0x00000034 stw ea, 4isp) ig oioooooouo
000000035 stw ra, G(sp) £lo 0x00000000
0x0000003c stw 1:22,.12(31.31 rll 0%00000000
Ox 00000040 rdctl et, ipending rlz 0x00000015
0x00000044 bne et, zero, Ox4 (0x0000004c: CHECK_LEVEL_0) rl3 00000000
rld 000000000
NOT_EI: rls 010000050
000000045 br Oxle (Ox00000065: END_ISR) rle Ox 10002000
—| |17 000000000
-
| CHECT TR0 —| |15 000000000
il AN 0x00000000
Disassembly / Breakpoints /'{ Memary /'{ Watches /'{ Trace | rzo 0x00000000 |
Terminal = # | Info & Errors - X
JTAG UART link established using cable "USE-Elaster Symbols loaded. -
[USE-0]", dewice 1, instance 0x00 Source code loaded.
INFO: Program Trace not enabled, because trace requires
BREAK: Program break @ 0x000000Z0
[+
Info & Errars | GDB Server

Figure 29. The interrupt handler.

media_HAL.c file. The set of device driver functions provided for an IP core is specified as part of the documentation

for that IP core.

Compile and load the program by using the command Actions > Compile & Load. The Monitor Program automat-
ically compiles both the media_HAL.c program and all device drivers that it uses. In subsequent compilations of the

program, only the media_HAL.c code is compiled.

Run the program. It performs the following:

* Records audio for about 10 seconds when KEY[1] is pressed. LEDG[O0] is lit while recording

* Plays the recorded audio when KEY[2] is pressed. LEDG[1] is lit while playing

* Draws a blue box on the VGA display, and places a text string inside the box

» Shows a text message on the 16 x 2 character LCD display

* Displays the last three bytes of data received from the PS/2 port on the HEX displays on the DE2 board
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@0x000006958
0x0000069C
0x000006a0
0x00000624
0x000006a8

Ox000006ac

0x000008h0

# New Project Wizard

Specify program details

~Source files

X

First source file is used to determine the name of the binary program fFile,

[:iMonitor_Program_TukorialsiMonitor _Inkerrupks_Clinkerrupk_example.c Add...
D:\Monitor_Prograrm_Tutorials\Maonitar _Inkerrupts_Clexception_handler.c

[:iMonitor_Program_TukorialsiMonitor _Inkerrupts_Clinkerval _timer_TSR.c

[:\Monitor_Program_Tutorials\Monitar_Inkerrupts_C\pushbutton_ISR.c

Crown

-Program options

Additional compiler flags: |-01 -ffunction-sections -Fverbose-asm -fro-inline

Additional linker Flags: |

[ Use small C library Emulate unimplemented instructions

Source files highlighted in blue are sample program files, which will be created in the project directory,

| < B_ack| [ met =] | Einish | | Canicel |

Figure 30. The source files for the C code interrupt example.

woid interrupt handler(woid)
i
interrupt handler:
addi sp, sp, -0x8
stw ra, 4(sp)
stw rla, O(sp)
int ipending;
NIOSZ_READ IPENDING(ipending) ;
rdctl rla, ipending

if | ipending & 0x1 ) /¢ interwal timer is interrupt lewel 0

andi r2, rla, Oxl
heq rZ, zero, Ox4 (0x000008b4)
i
interval timer isr( ):
call 0x000001bd (0x000006d0: interval timer isr)
'

Figure 31. The interrupt handler.

More details about developing programs with the Monitor Program that use HAL device drivers can be found in
the tutorial Using HAL Device Drivers with the Altera Monitor Program, which available on the University Pro-
gram section of Altera’s website. More information about HAL can be found in the Nios II Software Developer’s

Handbook.
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wolatile int * interwal timer ptr = (int *) 0x10002000;

wolatile int * HEX3_HEX0 _ptr = (int *) 0x10000020; 4 HEX3 _HEXD addreas

wolatile int * HEX7_HEX4 ptr = (int *) 0x10000030; 4 HEXT_HEXA addreas

*linterval timer ptr) = 0; /¢ Clear the interrupt

interval_ timer isr:

0x00000&d0 orhi r2, zero, 0x1000
O0x000006d4 addi ri, rZ, Oxz0oo E
O0x000006458 stwio zero, O(r2)

Figure 32. The interrupt service routine for the interval timer.

10 Working with Windows and Tabs

It is possible to rearrange the Monitor Program workspace by moving, resizing, or closing the internal windows
inside the main Monitor Program window.

To move a particular window to a different location, click on the window title or the tab associated with the window,
and drag the mouse to the new location. As the mouse is moved across the main window, the dragged window will
snap to different locations. To detach the dragged window from the main window, drag it beyond the boundaries
of the main window. To re-attach a window to the main window, drag the tab associated with the window onto the
main window.

To resize a window, hover the mouse over one of its borders, and then drag the mouse. Resizing a window that is
attached to the main window will cause any adjacent attached windows to also change in size accordingly.

To hide or display a particular window, use the Windows menu. To revert to the default window arrangement,
simply exit and then restart the Monitor Program. Figure 33 shows an example of a rearranged workspace.
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#* Altera Monitor, Program [Nios 1]

Eile  Settings Actions  Windows  Help altera Manikar Program [Mios 11]
WE R+sB 2 nl i
Disassembly — % | Memory — ¥ | Registers - X

Goto instruction | Address (hex) or symbol name: Goto memory address | Address (hex): Mw

a a

[0

| [

Terminal — ¥ | Info & Errors - X

L]

Info & Errors j‘ DB Server |

Figure 33. The Altera Monitor Program with a Rearranged Workspace.
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11 Appendix A

This appendix describes a number of Monitor Program features that are useful for advanced debugging or other
purposes.

11.1  Using the Breakpoints Window

In section 3.6 we introduced instruction breakpoints and showed how they can be set using the Disassembly window.
Another way to set breakpoints is to use the Breakpoints window, which is depicted in Figure 34. This window
supports three types of breakpoints in addition to the instruction breakpoint: read watchpoint, write watchpoint, and
access watchpoint, described below.

1. Read watchpoint: the Nios II processor is halted when a read operation is performed on a specific address
2. Write watchpoint: the Nios II processor is halted when a write operation is performed on a specific address

3. Access watchpoint: the Nios II processor is halted when a read or write operation is performed on a specific
address

Each of the above types of breakpoints requires the use of the Standard or Fast version of the Nios II processor.
These breakpoint types are not available when using the Economy version of Nios II.

In Figure 34 an instruction breakpoint is shown for the address 0x000058c. This corresponds to an address in
the program media_HAL.c, which we discussed in section 9. This program uses the DE2 Media Computer, which
includes the Standard version of the Nios Ii processor. In section 3.6 we showed how to create such an instruction
breakpoint by using the Disassembly window. But we could alternatively have created this breakpoint by right-
clicking in a grey box under the label Instruction breakpoint in Figure 34 and then selecting Add. A breakpoint
can be deleted by unchecking the box beside its address.

Setting a read, write, or access watchpoint is done by right-clicking on the appropriate box in Figure 34 and speci-
fying the desired address.

The Monitor Program also supports a type of breakpoint called a conditional breakpoint, which triggers only when
a user-specified condition is met. This type of breakpoint is specified by double-clicking in the empty box under
the label Condition in Figure 34 to open the dialog shown in Figure 35. The condition can be associated with
an instruction breakpoint, or it can be a stand-alone condition if entered in the Run until box in the Breakpoints
window. In this example the condition entered is r2 == 5, and is associated with the instruction breakpoint. The
condition causes the breakpoint to trigger only if the Nios II register r2 contains the value 5. Note that if a stand-
alone condition is entered in the Run until box, then the Run button associated with this box must be used to run the
program, rather than the normal Actions > Continue command. The processor runs much more slowly than in its
normal execution mode when a conditional breakpoint is being used.

11.2  Working with the Memory Window

The Memory window was shown in Figure 23. This window is configurable in a variety of ways:
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+* Altera Monitor, Program [Nios I1] - Monitor_HAL. ncf : media_HAL.srec [Paused]

File Setings Actions Windows Help Altera Monitor Program [Nios I1] - Monitor_HAL.

HE & ¢ R @0 ml @

Breakpoints — ¥ | Registers - X
— Instruction breakpoink: Reg ‘alue
| Address | Instruction |C0nditi0n| pc 0x0000058c| |~
0x0000058ccall 0x00000234 (0x000008d0: check KEYs) EEED (UL
rl Ox 00000000
— Read watchpoint: rz OxEEEEEEEE
| address r3 OxfEEEEEEE
. . rd Ox007EEEhE
— Write watchpoink: s 0x007EEEhG
JM ré Ox007E£££c0
— fecess watchpoint: 7 0x0000674c
J.ﬂddress ra Ox0000000£
ro 0x00001587E
— Run until: rlo 0x00000051
Condition rll 000000088
Run riz 0x00000001
rl3 Ox 00000000
rld 00000000
rls Ox00000000
rlé O0x 0000687
rl7 0x000065354
rls Ox00000000
Disassembly . Breakpoinks )" Mamary )'{ Watkches )'{ Trace | rla Ox007EEECD [+
Terminal - | Info & Errors - X
Opened character LCD dewvice INFO: Program Trace not enabled, because trace requirfa
Opened character buffer device BREAK: Frogram break @ 0x0000058c
Opened pixel buffer device BREAK: Program break [ 0x000005&c
Opened PS2 dewice BREAK: Program break @ 0x<0000058c

Opened audio dewice EREAK: Program break @ 0x0000058c

Opened pushbutton FEY dewvice
Opened green LEDs dewice

[»]

Info & Errors [ GDE Server |

Figure 34. The Breakpoints window.

* Memory element size: the display can format the memory contents as bytes, half-words (2-bytes), or words
(4-bytes). This setting can be configured by right-clicking on the Memory window, as illustrated in Figure 36.

* Number of words per line: the number of words per line can be configured to make it easier to find memory
addresses, as depicted in Figure 37.

* Number format: this is similar to the number format option in the Register window, described in the previous
section, and can be configured by right-clicking on the Memory window.

* Display order: the Memory window can display addresses increasing from left-to-right or right-to-left.

11.2.1 Character Display

The Memory window can also be configured to interpret memory byte values as ASCII characters. This can be
done by checking the Show equivalent ASCII characters menu item, accessible by right-clicking on the Memory
window, as shown in Figure 38.

The right side of Figure 38 shows a sample ASCII character display. Usually, it is more convenient to view the
memory in bytes and characters simultaneously so that the characters appear in the correct sequence. This can be
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Synkax
Register values:
pe, rl, k2,

Murnber Formats:
decimal: ###
hexadecimal: Oxa##
ockal: O###
binary: Ob###

Operatars:
===, <, = <= o=, b |
ot %

ACCEssing memary
mem&( address : byte value at address
meml6l address ) half-word walue at address
mem32; address ) word value at address

Figure 35. The Conditional breakpoint dialog.

Oxo00ooooo

0x00000010 e (R
0%00000020 Mumber of wards per line Half-word (2-bytes)
0x00000030 MNumber Format 4

0x00000040 Display order b | dadl0als
Ox00000050 dh400els
0%00000060 Switch to character mode ehEEEENA
0x00000070 Show equivalent ASCIT characters 10000326
Ox00000050 df401z215
000000090 Goko memory address... df401217
0x000000a0 Mermory ... A5E00317
O0x000000b0 Load file into memary. .. d9500717
Ox000000c0 dadonbl?

Figure 36. Setting the memory element size.
accomplished by clicking the Switch to character mode menu item, which can be seen in Figure 38. A sample
display in the character mode is shown in Figure 39.

It is possible to return to the previous memory view mode by right-clicking and selecting the Revert to previous
mode menu item.

11.2.2 Memory Fill

Memory fills can be performed in the Memory window. Click the Actions > Memory fill menu item or right-click
on the Memory window and select Memory fill. A Memory fill panel will appear on the left-side of the Memory
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Ox00000000 View as » Oobffdla
000000010 Humb F 4 I , 1
Mumber of words per line
0x00000020 Mumber of words per line 1
0%00000030 Mumber Format » Z
0200000040 Display arder 4
000000050 } g
0x00000080 Switch to character mode s
0x00000070 show equivalent ASCII characters a2
000000050 -
0x00000090 GQobo memory address... 64
0x000000a0 Memary Fill. .. Auta
0x000000b0 Load file into memary. .. kb
Ox000000c0 SO TTHOTS LY T dad00bl?

Figure 37. Setting the number of words per line.

0x00000000 : gbhf 10 16 | 0000 :HOO 0000
0x00000010 LS L T 40B0 OV¥@EO :hOO
0x00000020 Humber of wards per line P iz 40 ds 15 0oDO00 ODOO0OO0 OO0RO
0x00000030 Mumber Format » 640 d2 15 |00DOO0 OOOO OORDO
0x00000040 Display order y I500da 15 |0D0DOO0 =zoOO O OO
0x00000050 do0dh 15 |DOOO OOOO O OO
0x00000060 Switch to character mode 140d? 04 |DODDOO0 OOOO OORD
0x00000070 = - D802 26 (0000 :1 0O LODO¢
Show equivalent ASCIT charackers
0x00000080 30000 15 =00 oooo oood
0x00000090 Goto memory address. .. 140d% 17 |0DOOO :0=0 0O0O@DO
0x000000a0 Mermary Fil... 240d5 17 |DODO =zpO{ OORD
0x000000b0 L £40d% 17 |0DO0OO0 OOOO OO@DO
Load File inka memary. ..
0x000000c0 a40da 17 |DODO O OO O @O

Figure 38. Checking the Show equivalent ASCII characters menu item.

window. Simply fill in the desired values and click Fill.

11.2.3 Load File Data into Memory

Data stored in a file can be loaded into the memory by using the Memory window. This feature is accessed by
selecting the command Actions > Load file into memory or by right-clicking on the Memory window. The Load
file panel will appear on the left side of the Memory window, as illustrated in Figure 40, to allow the user to browse
and select a data file. The user provides a base address in memory where the data should be stored. Three types
of data files are supported: Intel HEX-format files, Binary files, and Delimited hexadecimal value files. Intel HEX
format is a widely-used standard in which data is expressed as records of hexademical values. The Monitor Program
supports Intel HEX-format files, which have the filename extension .hex, with 8-bit word size. The format of these
files can easily be obtained by searching on the internet. The Binary file type is simply an unformatted data file.
Each byte in the file is read by the Monitor Program in sequence and stored in the memory.

The Delimited hexadecimal value file format is unique to the Monitor Program. The format of these files is illustrated
in Figure 41. The file consists of any number of lines, where each line comprises a comma-separated list of data
values. Each data value is expressed as a hexidecimal number with an optional - sign. When using a delimited
hexadecimal value file in the Load file panel, two additional parameters can be specified: the value of the delimiter
character (comma is the default), and size in bytes of each data value (1 is the default).
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Memory -
Goto memory address | Address (hex): |:| [] Query All Devices
Ox00020000 6l 62 63 64 65 66 67 68 69 6a &b &c Gad abocd efogh iik1
Ox00020010 71072 73 74 75 76 77 78 79 7a Th Tco 7d qgrst uwwx ¥z fl
Ox00020020 cq 7f fe cf e5 de 19 ec a3 d9 fe 7f bd oooao oooano Oo0a0oao
Ox00020030 32 75 ed b4 7h £d 59 &9 bbh 85 bb bS Tz Zzu00 {0Y i Oo0a0oao
Ox00020040 £ff ac c3 £f £5 62 fc fe 77 %9e 67 T2 de oooao Ob =0 wil gz
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Figure 39. Character mode display.

Memory -

Goto memory address | Address (hex: |:| [] Query &l Devices | Refresh Memary

Load file

0x000103£0  073£5fb9  bdeb6efb  7ab639be  fEEFfefl
0x00010400  4b2c8980  046ac2f8  a2l08e20 24020680
0x00010410 12210426 15816099  adc96558  205c43df
0x00010420  0d546fc)  840854ed  69£c4922  00b206ad
File type: 0x00010430 34640032 28198071  90ab009%  a8501112
Stmtaddmss(heﬂ:[::::::::] 0x00010440  fe00agbhl  e2806Zad 42600351  0Oc3asiac
0x00010450 70032100  04b1830e  50al870b  le698228

0x00010460  0OcOe9l8e  229aZedd 46404043  0e25091c

0x00010470  £5340e3d  091a9500 39200206 74642829
0x00010480  cO£09124  bloO0aB2  eef9018l  Be606198
0x00010490 98200081  0b386dl0  3fb53101  4ebS05h2
0x000104a0  0b2044cd  6bS0d075  998009b3  308c2fl8
0x000104b0  3le0322c  83052ald4  323ebale  19b02b34
0x000104c0 40446604  4ce49cfe  2452cd24  405066e5
0x000104d0  dlb027lc  04840all 36983051 20311943
0x000104e0  d9045924  7468949f  dce7lefs8  clagSe£s
0x000104£0  ba3c9e36 53105993  3ad4Saazd 99643150
4| [

Disassembly }f Breakpoints | Memary j ‘Watches }'{ Trace |

Seleck a file:

la]

Figure 40. The Load file panel.

11.3 Setting a Watch Expression

Watch expressions provide a convenient means of keeping track of the value of multiple expressions of interest.
These expressions are re-evaluated each time program execution is stopped. To add a watch expression:

1. Switch to the Watches window.

2. Right-click on the gray bar, as illustrated in Figure 42, and click Add.
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ae8,11,22,33

1844 ,2055,30866, 4877

10000088 ,20000099,3008008aa,4880888bb
1,-1,2,-2

Figure 41. A Delimited hexadecimal value file.

Watches -

Expression Walue

Figure 42. The Watches window.

3. The Edit Watch Expression window will appear, as shown in Figure 43. The desired watch expression can then
be entered, using the syntax indicated in the window. In the figure, the expression mem32 (sp) is entered,
which will display the value of the data word at the current stack pointer address.

Edit watch expression @

Synkax
Reqister values:
pE, 1, k2,

MNumber Farmats:
decimal: ###
hexadecimal: D
ockal: O ##
binary: Oba##

Operakars:
===, 2, = =, b B |
e

ACCESSING Memory
mema( address 1 byte value at address
mem16i address 1 half-word value at address
mem32( address )i word value at address

men3d (sp]|

Figure 43. The Edit Watch Expression window.

4. Click Ok. The watch expression and its current value will appear in the table. The number format of a value
displayed in the watch expression window can be changed by right-clicking on the row for that value. As the
program being debugged is repeatedly run, the watch expression will be re-evaluated each time and its value
will be shown in the table of watch values.
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11.4 The GDB Server Panel (Advanced)

To see this panel, select the GDB Server panel of the Monitor Program. This window will display the low level
commands being sent to the GDB Server, used to interact with the Nios II system being used. It will also show the
responses that GDB sends back. The Monitor Program provides the option of typing GDB commands and sending
them to the debugger. Consult online resources for the GDB program to learn what commands are available.

11.5 Running Multiple Instances of the Monitor Program (Advanced)

In some cases, it may be useful to run more than one instance of the Monitor Program on the same computer. For
example, the selected system may contain more than one Nios II processor. An instance of the Monitor Program is
required to run and debug programs on each available processor. As described in Section 3.1, it is possible to select
a particular processor in a system via the Processor drop-down list in the New Project Wizard and Project Settings
windows.

The Monitor Program uses GDB Server to interact with the Nios II hardware system, and connects to the GDB
Server using TCP ports. By default, the Monitor Program uses port 2399 as the base port, and to connect to each
processor in a system, the Monitor Program will attempt to use a port located at a fixed offset from this base port.
For example, a single system consisting of 4 processors corresponds to ports 2399-2402.

However, the Monitor Program does not detect any ports that may already be in use by other applications. If the Mon-
itor Program fails to connect to the GDB Server due to a port conflict, then the base port number can be changed by
creating an environment variable called ALTERA_MONITOR_DEBUGGER_BASE_PORT and specifying a different
number.

It is also possible to have more than one board connected to the host computer. As described in Section 3.1, a
particular board can be selected via the Host connection drop-down list in the New Project Wizard and Project
Settings windows. In this case, a separate instance of the Monitor Program is needed to interact with each processor
on each physical board. By default, the Monitor Program assumes a maximum of 10 Nios II processors per board.
This means that ports 2399-2408 are used by the Monitor Program for the first board connected to the computer, and
the first processor on the second board will use port 2409.

It is possible to specify a different value for the maximum number of processors per Nios II hardware system by
creating an environment variable called ALTERA_MONITOR_DEBUGGER_MAX_ PORTS_PER_CABLE and speci-
fying a different number. This is useful if a system contains more than 10 Nios II processors. It is also useful if a
port conflict exists and none of the systems contain 10 or more processors. In this case, decreasing this number (in
conjunction with changing the base port number) may provide a solution.

11.6  Examining the Instruction Trace (Advanced)

An instruction trace is a hardware-level mechanism to record a log of all recently executed instructions. The Nios I1
JTAG Debug Module has the instruction trace capability, but only if a Level 3 or higher debugging level is selected
in the SOPC Builder configuration of the JTAG Debug Module (See the Nios Il Processor Reference Handbook,
available from Altera, for more information about the configuration settings of the JTAG Debug Module). If the
required JTAG Debug Module is not present, a message will be shown in the Info & Errors window of the Monitor
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Program after loading a program, to indicate that instruction trace is not available.

The Trace window in the Monitor Program is provided for future expansion. It is not currently supported.
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